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Pixel Shift
What Is “Pixel Shift”?

Pixel shift allows you to take multiple pictures while shifting the camera's image sensor by a single
pixel or less and to merge them to generate a higher-resolution image than that which can be
obtained through normal single-frame shooting.

How Pixel Shift Works
The Bayer image sensor installed in general cameras including Nikon cameras can only capture one
type of color information (R, G, or B) per pixel. When displaying in RGB, the remaining colors must be
interpolated from the surrounding pixels. In the following example, color information is captured in the
ratio of R:1, G:2, and B:1, and each RGB channel captures the color information of the remaining pixels
through the interpolation process.
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In pixel shift shooting, taking multiple pictures while shifting the image sensor by one pixel unit allows
G or B to be captured at the pixel location where R was captured. Since RGB can be overlapped
without interpolation, moiré, and color fringing caused by the interpolation process can be reduced,
improving color reproducibility in the details.

The image sensor can also be shifted by units smaller than a single pixel. Since the camera captures
more detailed information, higher-resolution images than those captured by shifting one pixel unit can
be generated. Nikon cameras can shift the image sensor by 0.5 pixels.
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Pictures taken with the pixel shift shooting function can be merged into a single, high-resolution image
with Nikon's NX Studio software. Noise can also be averaged and reduced by merging multiple images.

D Images and Illustrations
The images and illustrations in this document are for expository purposes only.
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The Pixel Shift Workflow
Pictures taken using pixel shift cannot be merged within the camera. NX Studio allows you to generate
high-resolution images by merging pictures taken with pixel shift.

Step1 Step2 Step3

Step1: Take pictures for pixel shift merge with your camera
Take pictures using pixel shift to generate images for merging (0 20). Pixel shift shooting is available
with camera “C” firmware version 2.00 or later.

Step 2: Merge pictures taken using pixel shift with NX Studio
Merge pictures taken by the camera using pixel shift with NX Studio. Use NX Studio to view and
edit pictures shot with Nikon digital cameras ( 0 28). Use the latest version of the software to
merge pictures taken using pixel shift. NX Studio can be downloaded from the Nikon Download Center
(https://downloadcenter.nikonimglib.com/).

Step 3: Adjust merged pixel shift images with NX Studio or
third-party software
Adjust merged pixel shift images with NX Studio or third-party image processing software. The
brightness, contrast and other factors of merged pixel shift images can be adjusted with NX Studio
(0 35).

7 The Pixel Shift Workflow
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Single frame image Merged pixel shift image

Single frame image Merged pixel shift image

The Benefits of Pixel Shift
Here are the benefits of pixel shift.

Reducing Moiré and Color Fringing
Pixel shift can reduce moiré and color fringing because it does not interpolate between pixels.

Improving Color Reproduction of Details
Pixel shift does not interpolate between pixels regardless of whether it merges 4, 8, 16, or 32 pictures,
so color reproduction of details can be improved when compared to single frame shooting.
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Single frame image Merged pixel shift image

Single frame image Merged pixel shift image

Improving Resolution
By using pixel shift, more detailed information can be captured, resulting in high-resolution and
high-definition images.

Reducing Noise
Noise can be noticeably reduced by merging 8 or 32 pictures with NX Studio.
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Scenes Where Pixel Shift Is Effective
Here are some examples where pixel shift is effective and how to take advantage of it.

When You Want Images with a Larger Size or
Higher Definition
Pixel shift is effective when you want images with a larger size or higher definition. The resulting image
has four times the number of pixels of the original and it can be generated in a larger size. When 16 or
32 pictures taken using pixel shift are merged into a single image, the resulting height and width are
double those of the original pictures. For example, images taken at 8256 × 5504 pixels can be merged
to generate an image of 16,512 × 11,008 pixels.

© Taylor Gray
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Single frame image

Merged pixel shift image with quadruple the number of pixels
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When You Want High Quality Images with the
Same Size as Single Frame Shooting
Pixel shift is effective even when a large image is not needed. "Oversampling," in which higher-
resolution data is taken and then resized to a smaller size, can generate a high-definition and high-
quality image at a high resolution while having the same image size as single frame shooting. The file
size of the generated image is not significantly different from that of an image of the same image size
without oversampling and is recommended from an archive perspective.

If 32 pictures are merged to make a generated image and oversampled to be the same image size
with the merged image of 4 or 8 pictures, the resulting image will produce a higher image quality
than those counterparts.

© Taylor Gray
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Single frame image Merged pixel shift image from 8 shots

Merged pixel shift image from 32 shots, resized to
a single frame image size

Merged pixel shift image from 32 shots
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When You Shoot Subjects that Cause Moiré
Moiré occurs due to the relationship between the fineness (frequency) of a subject’s structure, its
colors, and the performance of the camera. It is difficult to eliminate moiré from pictures after
shooting, so it is important to prevent it during shooting. Pixel shift is effective when shooting subjects
with repeated fine structures, such as textiles, building roofs, or tile walls.

Regardless of the [Number of shots] setting (4, 8, 16, or 32 pictures), moiré may be less noticeable
compared to single frame shooting.
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Single frame image

Merged pixel shift image
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When You Need a Deeper Depth of Field or a Wider
Angle of View
Pixel shift is effective when you want to increase the area in focus or to include a wider area in the
picture. It can generate images with approximately four times the resolution of a single frame shot.
Therefore, it is possible to shoot away from the subject while maintaining the equivalent resolution of a
single frame shot. A longer distance from the subject may lead to lower magnification and a change in
perspective, but can also provide a deeper depth of field and a wider angle of view.

Single frame image shot at a focal length of 70 mm, aperture of f/8, and shutter speed of ¹/₂ s

Merged pixel shift image shot at a focal length of 70 mm, aperture of f/5.6, and shutter speed of ¹/₄ s

As shown above, pixel shift provides a better image quality and a deeper depth of field than a single
frame shot, even with a wider angle of view, a larger aperture value, and faster shutter speed achieved.
This allows you to take pictures with extra space and with a wider aperture than usual. It also reduces
the time and effort required for post-processing focus stacking.
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Single frame image Merged pixel shift image from 4 shots

Merged pixel shift image from 4 shots Merged pixel shift image from 8 shots

Tip: The Number of Pictures Taken during Pixel Shift Shooting
In pixel shift shooting, you can select the number of pictures taken from 4, 8, 16, or 32. This provides
several advantages during a pixel shift merge, depending on the number of pictures taken. More
advantages can be gained as more pictures are taken.

Number of
shots Advantages

4

Reducing moiré and color fringing, improving color reproduction of details and
resolution.

8

Reducing moiré, color fringing, and noise, improving color reproduction of details
and resolution.
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Merged pixel shift image from 4 shots Merged pixel shift image from 16 shots

Merged pixel shift image from 16 shots Merged pixel shift image from 32 shots

Number of
shots Advantages

16

Reducing moiré and color fringing, improving color reproduction of details and
resolution, doubling the image size.

32

Reducing moiré, color fringing, and noise, improving color reproduction of details
and resolution, doubling the image size.

The number of images generated, as merged pixel shift images can be selected if more than 4 shots
are taken. For example, when shooting 32 shots, 32 shots be merged into 1 image, and multiple
merged images can be generated (such as 2 images each from 16 shots, 4 images from 8, and 8
images from 4). Even if a merged image is disrupted due to blurring of the subject in some shots, the
desired merge result may be generated by changing the number of images to be generated. (0 32).
It is recommended to always take 32 shots unless there is a particular reason, such as shortening the
shooting time or saving storage device capacity.
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Notes on Pixel Shift
Pixel shift is a technique that takes multiple pictures of the same subject while gradually changing
in-camera settings and merges them into an image. Therefore, if some changes occur with the subject
during pixel shift shooting, the pictures cannot be successfully merged. It is recommended to use pixel
shift only when shooting a completely static subject with the camera fixed on a tripod or similar device.

Conditions Unsuitable for Pixel Shift Merge
The desired merge results may not be generated if any of the following conditions occur during pixel
shift shooting:

When the subject moves: Moving subjects (people, animals, etc.) are not suitable for pixel shift
merge.

Even if shooting a completely static subject such as a building, if there is something moving
within the angle of view, the merge of that area may not work.
The desired merge result may not be generated if the subject looks like it is moving due to
atmospheric fluctuations (heat haze, mirages, etc.) when shooting landscapes.

When the camera moves: Be sure to fix the camera on a tripod or similar device. Even when the
camera is fixed on a tripod, it may be shaken by wind or vibrations caused by people or cars passing
by.

When the brightness of the subject changes: Changes in the brightness of the subject due to
changes in weather conditions, sunrise and sunset, flickering lighting, etc. will affect the merge
result.

Shooting Time
It is difficult to control external factors such as light, atmosphere, and ground during shooting. The
longer the shooting time, the more susceptible the camera is to external factors, so it is recommended
to set the camera to complete shooting in as short a time as possible.

Tip: Raise the ISO Sensitivity to Shorten the Shooting Time
Even if the ISO sensitivity is set to a low value, a high-resolution image may not be available due to
external factors depending on the shooting time. In these cases, it is recommended to raise the ISO
sensitivity and shorten the shooting time. For example, when shooting with 32 pictures, better results
are expected by shooting at ISO 500 and a shutter speed of 4 seconds than at ISO 64 and a shutter
speed of 30 seconds.
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Pixel Shift Shooting
Before Pixel Shift Shooting

Note the following before starting pixel shift shooting.

Choose a Static Subject
As mentioned in "Notes on Pixel Shift" (0 19), choose a static object as the subject. Examples of
subjects suitable for pixel shift merge include:

Buildings
Objects
Specimens and taxidermy mounts
Landscapes

Fix the Camera
Be sure to fix the camera on a tripod or with a camera arm so that it will not move during pixel shift
shooting. Choose a location where the tripod is not subject to vibrations from the ground or wind.
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If unexpected bright spots appear in a shot taken during pixel shift
shooting, performing a pixel shift merge may cause them to be
more noticeable. We recommend using [Pixel mapping] in the
setup menu before shooting.

An optional flash unit can also be used during pixel shift shooting.
Choose a longer interval in [Pixel shift shooting] > [Interval until
next shot] than the time needed for the flash to charge, so that the
flash can fire at a constant intensity for each shot.

Banding and uneven colors may occur during a merge due to
variations in light intensity. If uneven colors are noticeable, use
a flash unit with stable flash output. Also, uneven colors can be
reduced by increasing noise reduction when adjusting merged
pixel shift images.

You can select [HLG] for [Tone mode] in the photo shooting menu
to take NEF (RAW) pictures that can be saved as HEIF copies with a
wide dynamic range.

Perform Pixel Mapping

Set Functions That Can Be Used with Pixel Shift
Shooting
The following camera features can be used in combination with pixel shift shooting. Configure the
settings before shooting begins.

Added features for pixel shift shooting with “C” firmware version 3.00. See "Features Available with
'C' Firmware Version 3.00" for details ( 0 40).

Flash Photography

Tone Mode [HLG]
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Image areas can be selected using [Image area] in the photo
shooting menu. Image areas other than [FX (36 x 24)] can also
be set for pixel shift shooting.

Image Area
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You can adjust pixel shift shooting settings in [Pixel shift shooting]
in the photo shooting menu.

Pixel Shift Shooting Settings
Pixel shift shooting can be set using the camera or NX Tether.

Using the Camera

Option Description

[Pixel shift shooting mode]

[On (series)]: Take multiple series of pixel shift pictures. To end
pixel shift photography, select [Pixel shift shooting mode] again
and choose [Off].
[On (single photo)]: End pixel shift photography after recording
a single series.
[Off]: End pixel shift photography.

[Number of shots]

Choose the number of shots taken each time the shutter-release
button is pressed.

Long series require more time to record but produce better-
quality results when merged into a single image.
Unless there is a particular reason, 32 shots is recommended.

[Delay] Choose the delay between the shutter-release button being pressed
all the way down and the start of pixel shift photography.

[Interval until next shot]

Choose the interval between shots, in seconds.
If you are using an optional flash unit, choose an interval longer
than the time needed for the flash unit to charge. If the interval is
too short, it may not fire or fire at less than the power needed for
full exposure.
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Assigning [Pixel shift shooting] to the i menu: Assign [Pixel
shift shooting] using Custom Setting f1 [Customize i menu] to
promptly move to the [Pixel shift shooting] settings display.

Assigning [Pixel shift shooting] to a custom control: [Pixel
shift shooting] can be assigned to a control using Custom
Setting f2 [Custom controls (shooting)].

Rotate the main command dial while pressing the assigned
control to change the [Pixel shift shooting mode] setting.
Rotate the sub-command dial while pressing the assigned
control to change the [Number of shots] setting.

-

-

Switching between multiple settings with [Shooting menu
bank]: Save the pixel shift shooting settings in the camera with
[Shooting menu bank] in the photo shooting menu to promptly
recall them when needed. This is effective when managing
multiple shooting settings. See “Recommended Settings” >
“Camera” > “Storing and Selecting Menus Used for Pixel Shift
Shooting” for details ( 0 50).

Tip: Functions and Settings Useful for Creating Shortcuts for
Pixel Shift Shooting
Here are recommended functions and settings useful for creating shortcuts for pixel shift shooting.
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Using NX Tether
Use NX Tether “tethered photography” software to take pictures while a camera is connected to the
computer. Click [Pixel shift shooting] in the [Shooting Settings] pane to adjust shooting settings.
Available settings are the same as those in the camera menu. Select [ON] to enable pixel shift
photography at the selected settings.

Download NX Tether from the Nikon Download Center (https://downloadcenter.nikonimglib.com/).
Use the latest version of the software for pixel shift photography.
For information on connection to NX Tether and its basic operations, see NX Tether online help
(https://nikonimglib.com/nx_tether/onlinehelp/en/).
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For information on connecting the camera to a computer via an Ethernet cable and controlling
the camera remotely from the computer, see “Computers: Connecting via Ethernet” (https://
onlinemanual.nikonimglib.com/z8/en/computers_connecting_via_ethernet_91.html) and “What You
Can Do When the Camera Is Connected to a Computer or FTP Server” > “Camera Control” (https://
onlinemanual.nikonimglib.com/z8/en/uploading_pictures_94.html) in Z 8 Reference Guide.
If an insufficient number of pixel shift pictures are downloaded from the camera, consult
“Troubleshooting” > “Not All Pictures Taken in Tethered Photography Are Downloaded” ( 0 54).

Tip: Making the Most of NX Tether
NX Tether comes with convenient features. Customize the settings according to your objectives and
situation.

Changing downloaded file names: Select [File Name] under the [Tools] menu > [Options]
> [Destination] tab to specify image file names. Selecting [Same as camera] for [Naming
convention] enables the use of the same file names as those saved with your camera, making
file handling easier. You can also set prefixes or suffixes to generate unique file names.

Increasing the number of the live view framing grid lines: Select [Horizontal line count] or
[Vertical line count] in [Framing grid display] under the [Tools] menu > [Options] > [Lv] tab to
customize the number of framing grid lines displayed on the live view image.

26 Pixel Shift Shooting Settings

https://onlinemanual.nikonimglib.com/z8/en/computers_connecting_via_ethernet_91.html
https://onlinemanual.nikonimglib.com/z8/en/computers_connecting_via_ethernet_91.html
https://onlinemanual.nikonimglib.com/z8/en/uploading_pictures_94.html#topic_camera_control
https://onlinemanual.nikonimglib.com/z8/en/uploading_pictures_94.html#topic_camera_control


Drawing framing guides at the desired positions in live view: Click the show framing guides icon
in the live view window to display framing guides, which you can drag to any desired position.

Downloading pictures shot using the camera shutter-release button: Placing a check next to
[Enable Controls on Camera Body] in the [Camera] menu automatically downloads pictures taken
with the camera shutter-release button to your computer.

Measuring preset manual white balance to apply to photos: With version 2.3.0 or earlier, you
cannot measure preset manual white balance in photo mode. Instead, switch to video mode to
measure preset manual white balance, then switch back to photo mode to apply the obtained
preset data to photos.
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Merge Pictures Taken Using Pixel Shift
Merge Pictures Taken Using Pixel Shift
with NX Studio

Merge pictures taken using pixel shift with NX Studio. The software will detect the pixel shift sequence
of the selected picture and the pictures in the sequence can be merged into a single file.

Using Pixel Shift Merge
Display the folder containing the pixel shift sequence, and click [Pixel shift merge] in the
toolbar.

The [Pixel Shift Merge] dialog will be displayed where you can choose a series of pictures
taken with the camera using [Pixel shift shooting].
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In the [Pixel Shift Merge] dialog, adjust settings such as "Merge mode" (number of generated
images) and "Chromatic aberration correction" (0 30).

Click [Start] to save merged pixel shift images in the selected destination folder.
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Pixel Shift Merge Setting Options
Set options in the [Pixel Shift Merge] dialog as follows:

Option Description

Pixel shift sequence
Select the sequence to merge. If there are multiple
sequences in the view area, they can be selected and
merged at the same time.

[Merge mode]
Select the number of images to generate after
merging. The number of images depends on the
number of pictures to be merged (0 31).

[Chromatic aberration correction] Select [On] to reduce lateral color aberrations.

[Destination] Choose the destination folder for the generated
images.

[File name] Name the generated files. Click [Naming options]
to select how files are named with prefix and suffix.
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Number of Images Generated
The number of generated images that can be selected varies as follows according to the number of
pictures to be merged:

No. of
original
pictures

No. of
generated

images
Details

4 1 One merge to generate 1 image from 4 pictures.

8
1 One merge to generate 1 image from 8 pictures.

2 Two merges to generate 2 images from 4 pictures.

16
1

One merge to generate 1 image from 16 pictures.
The resulting height and width are double those of the
original pictures.

4 Four merges to generate 4 images from 4 pictures.

32

1
One merge to generate 1 image from 32 pictures.

The resulting height and width are double those of the
original pictures.

2
Two merges to generate 2 images from 16 pictures.

The resulting height and width are double those of the
original pictures.

4 Four merges to generate 4 images from 8 pictures.

8 Eight merges to generate 8 images from 4 pictures.

When multiple sequences of pictures taken using pixel shift are selected at the same time, it is only
possible to generate a number of images that are available to all selected sequences. For example, if
a sequence of 8 pictures and a sequence of 16 pictures are selected at the same time, only 1 image
can be generated; if a sequence of 8 pictures and a sequence of 32 pictures are selected at the same
time, you can select whether 1 or 2 images will be generated.

Tip: Time Required for Merging
The read/write speed of the hardware greatly affects the processing time of a pixel shift merge. A fast
read/write storage device such as an SSD is recommended.
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Tip: When the Merged Image Is Partially Disrupted
If the camera, the subjects, or the light source moves during a pixel shift shooting, the merged image
may be partially disrupted. The following figure shows how 32 pictures are merged into a single image.
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If a merge includes pictures disrupted, the resulting image will be partially disrupted.
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An example of a disrupted merged image caused by a moving subject during the 17th picture.

In these cases, we recommend changing the number of merged images to be generated. Increasing
the number of generated images may change the image quality of the merged image, but the merged
image can be generated with pictures that do not include the cause of the disruption. Set the number
of generated images with [Merge mode] in NX Studio when performing a pixel shift merge. The
number of generated images can only be selected if 32, 16, or 8 was selected for [Pixel shift shooting]
> [Number of shots] in the photo shooting menu. The relationship between each picture taken with
number of shots set to 32 and the resulting merged images is as follows:
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No. of generated images The relationship between pictures taken and the merged images to
be generated
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When generating a single image, the merged image is disrupted because all the pictures are used,
including those that were disrupted. Generating two images, on the other hand, causes the first
merged image to be generated using the first to 16th pictures and the second merged image to be
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generated using the 17th to 32nd pictures, so the first merged image, which does not include the 17th
disrupted picture, will not be disrupted. The desired result is more likely to be achieved by generating
a single image that produces the highest image quality first, and if disruption occurs, by increasing the
number of generated images in the order of 2 images, 4 images, and 8 images. It is also recommended
to always take 32 shots unless there is a particular reason not to.

When 32 pictures are taken and 4 images are generated, each image is made of 8 pictures, and
note the discontinuity of the combination of the 8 picture components to be merged. Consequently,
a better result may be obtained by choosing to generate 1 image merging 8 pictures when 8
consecutive pictures are taken in the shortest possible time. Specifically in situations where the
brightness changes quickly (sunrise, sunset, etc.), it is recommended to set the number of shots to 8.
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Take Advantage of Pictures Taken
Using Pixel Shift
Adjust/Export the Images with NX Studio

Pixel shift images merged with NX Studio can be adjusted in the adjustments/info palette
[Adjustments] pane. Exported (converted) images can be adjusted or processed with third-party
image editing software.

Adjust Merged Pixel Shift Images
Adjust images using tools in the [Adjustments] pane. Adjust settings such as [Picture Control],
[Exposure Comp.], and [White Balance] as necessary. The tools that can be used to adjust merged
pixel shift images are the same as ones for normal RAW (NEF/NRW) images. For detailed instructions
on how to use NX Studio, see the documentation provided with the software or online help.
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With the [Noise Reduction] item, you can set the amount of
processing to reduce noise in the merged images. For merged
pixel shift images, select [Resolution-priority pixel shift merge]
to completely disable [Noise Reduction]. Since noise reduction is
not performed, noise remains in the image, but the resolution of
the image is maintained.

[Resolution-priority pixel shift merge] is off
(the default setting)

[Resolution-priority pixel shift merge] is on

Noise Reduction

Tip: Noise Reduction
[Noise reduction] is not available for HEIF pictures. To process [Resolution-priority pixel shift
merge], select [SDR] for [Tone mode] in the photo shooting menu in the camera before taking
pictures.
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Export Merged Pixel Shift Images
Click [Export] in the toolbar to export merged pixel shift images in JPEG, HEIF, or TIFF format.

Choose a format, adjust image quality, size, and other settings, and click [Export] to export the files to
the selected destination folder.
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Tip: Using Third-Party Image Editing Software That Supports
the NEFX Format
When using third-party image editing software that supports images in the NEFX (merged pixel shift)
format (extension: .nefx), save the image using [Save] or [Save As] in the [File] menu. In these cases,
select [Save adjustments, labels, and ratings to the original image file] in the [Save] category of
the options dialog before saving the image.
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Using Third-Party Software
Exported image files can be further processed and edited using third-party image editing software.
Use image editing software that supports images in NEFX (merged pixel shift) format (extension: .nefx)
to open a merged pixel shift image as is without converting it to JPEG or TIFF format.

Software Manufacturers Providing Image Editing
Software That Supports the NEFX Format
The following software manufacturers provide image editing software that supports the NEFX format. For
detailed information on the software, visit the respective manufacturer's website.

Software manufacturer URL

Adobe https://www.adobe.com/products/photoshop-
lightroom.html

Capture One http://www.captureone.com/

Nikon does not recommend or guarantee operation of above software.
NEFX is supported in Adobe Camera Raw version 16.1.1or later.
NEFX is supported in Capture One version 16.3.4 or later.

Adobe
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A [Starting storage folder] item has been added to [Pixel shift
shooting] in the photo shooting menu.

Selecting (M) [New folder] automatically creates a new folder
for each new sequence.
Selecting (M) [Reset file numbering] when [New folder] is
selected (M) resets file numbering to 0001 whenever a new
folder is created.

Changes with Camera “C” Firmware
Version 3.00
Features Available with “C” Firmware
Version 3.00

The features added with camera “C” firmware version 3.00 are summarized below.

● Focus Shift and Pixel Shift Shooting Can Be Used Simultaneously ( 0 42)
[Options] has been added under [Focus shift shooting] in the photo shooting menu to
enable [Pixel shift shooting]. This combination allows you to perform pixel shift shooting while
automatically varying the focus position, producing higher resolution images that focus across a
wide range.

● Pixel Shift Shooting and AE Bracketing Can Be Used Simultaneously ( 0 46)
[Options] has been added under [Pixel shift shooting] in the photo shooting menu to enable
[AE bracketing]. This combination allows you to perform pixel shift shooting while automatically
varying exposure, producing higher resolution images with a wide dynamic range.

● New Folders Can Now Be Created During Pixel Shift Shooting

● Pixel Shift Can Be Set with a Self-Timer
Pixel shift shooting can now be set when [Self-timer] release mode is selected. Note that Custom
Setting c2 [Self-timer] will be disabled. The delay between the shutter-release button being pressed
all the way down and the start of pixel shift photography can be set via [Pixel shift shooting] >
[Delay] in the photo shooting menu.
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Added Custom Setting a14 [Maximum aperture Lv]: When set
to [On], the shooting display appears with the maximum aperture
regardless of the actual aperture. This improves both live view
quality and autofocus precision in low-light conditions.

Added a [Minimum] option to Custom Setting c2 [Self-timer]
> [Interval between shots]: Selecting [Minimum] for [Interval
between shots] allows self-timer shooting at intervals shorter
than 0.5 seconds.

Added a [400%] option to [Zoom on/off] in Custom Setting
f2 [Custom controls (shooting)]: Pressing the control assigned
this role allows you to easily zoom the display up to 400%,
centered on the current focus point.

Tip: Other Useful Features Added in the Firmware Update
Updating to “C” firmware version 3.00 also provides the following new features. See the Z 8
Supplementary Firmware Update Manual for details.
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Using Focus Shift Shooting and Pixel Shift
Shooting Simultaneously

With camera “C” firmware version 3.00, you can now set [Pixel shift shooting] from [Focus shift
shooting] > [Options]. Combining "focus shift shooting," which automatically shoots while varying
the focus position, with "pixel shift shooting" allows you to produce high-resolution images that focus
across a wide range.

About Focus Shift Shooting Combined with Pixel
Shift Shooting
Focus shift photography is a feature that varies the focus position after taking a photo to shoot the
next one. When combining focus shift shooting with pixel shift shooting, the camera performs a pixel
shift sequence consisting of the set number of shots, with varying focus position according to the
number of shots specified in the focus shift settings.
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You can use the camera to automatically take high-resolution photos with different focus positions and
use image editing software to merge these photos by depth compositing to produce high-resolution
images that focus across a wide range.

© Paul Van Allen
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Selecting [Pixel shift shooting] under [Focus shift shooting]
> [Options] in the photo shooting menu displays the following
options.

[Number of shots]: Select the number of pixel shift shots taken
at each focus shift interval. A long series will require more time
to record but will produce better-quality results when merged
into a single image.
[Interval until next shot]: Choose the interval between pixel
shift shots, in seconds. This setting overrides the interval set for
[Focus shift shooting] > [Interval until next shot].

Configuring Focus Shift and Pixel Shift Shooting
Combination

Tip: Vibration Reduction When Shooting Photos to Be Merged
Pixel shift shooting uses the camera's vibration reduction mechanism to shift the image sensor.
Vibration reduction can be disabled for focus shift photography. There may be slight differences in
the captured area between photos taken when using focus shift without vibration reduction and those
taken using the combined focus shift and pixel shift shooting, preventing these images from being
merged successfully. To align the captured area, you can either:

Select [Normal] or [Sport] for [Vibration reduction] when performing focus shift shooting only, or
Extract one shot from each pixel shift sequence in the combined focus shift and pixel shift shooting,
then merge these shots.

Tip: Focus Step Width
The “focus step width” item in focus shift photography determines the amount of focus movement
based on a calculated defocus value that accounts for the set step width and the aperture value of
the lens (considering the effective f-number and how many stops the aperture is stopped down from
maximum aperture). For example, when using a lens with a maximum aperture of f/2.8, shooting at a
focus step width 1 with an aperture of f/5.6 will result in different movement amounts from shooting at
step width 1 with an aperture of f/8 (the step size 1 at f/8 will move more than step size 1 at f/5.6). We
recommend setting the focus step width to 1, since the focus movement amount is adjusted according
to the aperture value. When combining focus shift with pixel shift shooting, use an aperture value of
f/4 to f/5.6 and a step width of 1 to make the most of pixel shift. Note that using a smaller aperture
than f/4 to f/5.6 may increase the effects of diffraction, while using a larger aperture may result in a
shallower depth of field, and both interfere with focus stacking performance.
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Tip: Number of Shots Required for Focus Stacking
We recommend taking a test shot to determine the number of shots required for focus stacking.
Confirming the required number of shots in advance is important when combining focus shift and
pixel shift shooting, as it can significantly reduce both shooting time and post-processing time
considering the enormous total shot count this technique requires. Here is how to find the required
number of shots for focus stacking:

1. Move the focus position to the closest point on the subject.
2. Set [Focus step width] and [No. of shots] to desired values and [Focus position auto reset] to

[OFF] for focus shift shooting and choose [Start].
We recommend setting [Focus step width] to [1] and [No. of shots] to [50].

3. Review shots in the playback display to confirm whether the focus moved all the way to the
farthest point you want in focus.

If the focus didn't move far enough, return to Step 2, increase the value for [No. of shots] and
perform focus shift shooting again.
If the focus has moved all the way you want, determine which shot number of the sequence
corresponds to the focus position at the intended farthest point and proceed to the next step.

4. Set the [No. of shots] based on the shot number that reached the focus position at the intended
farthest point.

For example, if you set the number of shots to 50 and the focus reached the farthest point in
the 37th shot, this means you have taken all necessary shots for focus stacking between shots
1 and 37. Set [No. of shots] to [37].
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Using Pixel Shift Shooting and AE
Bracketing Simultaneously

With camera “C” firmware version 3.00, you can now set [AE bracketing] from [Pixel shift shooting] >
[Options]. Pixel shift photography previously required manually changing the exposure for each pixel
shift shooting sequence, but now selecting AE bracketing enables automatic capture of high-resolution
photos at different exposure levels.

About Pixel Shift Shooting Combined with AE
Bracketing
When combining pixel shift shooting with AE bracketing, the camera performs a pixel shift sequence
consisting of the set number of shots, with automatically varying exposure levels according to the
number of shots specified in the AE bracketing settings. These pixel shift shots can be combined using
image editing software for HDR overlay, producing images with both high resolution and extended
dynamic range.
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Select [AE bracketing] under [Pixel shift shooting] > [Options]
in the photo shooting menu to select values for [Number of
shots] and [Increment] for exposure bracketing for each pixel shift
shooting sequence.

Configuring Pixel Shift Shooting and AE Bracketing
Combination

Tip: Shooting Fine-Detailed and High-Contrast Subjects
We recommend using auto bracketing together with [Number of shots] set to [4] for pixel shift
shooting when photographing subjects, with fine details prone to moiré patterns, such as buildings,
in high-contrast lighting conditions. Reducing the number of shots minimizes the required time to
complete the shoot while preventing disruptions in image overlay. This allows you to create images
with reduced moiré and wider dynamic range.
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Appendix
Recommended Settings

Here are recommended settings for pixel shift shooting and merging images.

Camera
“Pixel Shift Shooting“ in the Photo Shooting Menu ( 0 23)

Option Settings Description

[Pixel shift shooting mode] [On (series)] Take multiple series of pixel shift pictures.

[Number of shots] 32 pictures

Merging 32 pictures generates the highest quality
images. There will also be more options for the
number of images to be generated than other
settings. You will be able to choose the number of
generated images according to your purpose, such
as generating 2 merged images from 16 pictures
each or 4 merged images from 8 pictures each
(0 31).

[Delay] 2-5 seconds Reduce blur caused by camera shake when the
shutter-release button is pressed.

[Interval until next shot] 0 seconds Minimize shooting time.

i Menu and Custom Control Assignments
Assign [Pixel shift shooting] to the i menu or a custom control to promptly configure the settings for
pixel shift shooting (0 24). To support focus operation, it is recommended to assign [Zoom on/off] to
the lens Fn button or a custom control on the camera.
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“Series Playback“ in the Playback Menu
Option Settings Description

[List series as single thumbnails] [ON]

Only the first shot in each pixel shift shooting
sequence will appear in the thumbnail list. This
allows you to delete unsuccessful sequences or
upload all images in a sequence with a single
action.

“Camera Sounds“ in the Setup Menu
Option Settings Description

[Beep] [On]

Selecting [On] for [Beep] emits a sound when pixel shift
shooting is complete, making it easy to identify the end of a
shooting sequence even when using remote control or in tethered
photography.

[Type] Other than [Type E]
Always select an option other than [Type E] for [Type] as selecting
[Type E] may mute the beep when a beep and shutter sound
overlap.
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Storing and Selecting Menus Used for Pixel Shift Shooting
Photo shooting menu options can be stored in four banks (banks “A” through “D”) that can be selected
using [Shooting menu bank] in the photo shooting menu. For example, you can store optimal
settings for various shooting options; use the bank “A” for normal shooting, “B” dedicated to pixel shift
shooting, “C” to focus shift shooting, and “D” to auto bracketing.

Assign [Shooting menu bank] to the i menu or a custom control and use the control to make it
more efficient to switch between saved settings.
An example of photo shooting menu settings dedicated to pixel shift shooting is shown below. You
can customize these settings according to your preferences.

Option Settings

[Shooting menu bank] B

[Storage folder]

 
[Rename] _PXS_

[Select folder by number] 200

[RAW recording] [High efficiencym]

[Focus mode] [Single AF]

[AF-area mode] [Pinpoint AF]

[Pixel shift shooting]

 

[Pixel shift shooting mode] [On (series)]

[Number of shots] 32

[Delay] 2 seconds

[Interval until next shot] 0 seconds

Add a descriptive caption to the shooting menu bank name (“A”, “B”, “C”, or “D”) to distinguish each
bank. To rename a bank, highlight it, press 2, and select [Rename].
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NX Studio
“Pixel Shift Merge“ ( 0 30)

Option Settings Description

[Merge mode] [Generate one image]

By merging all the pictures in
series, a merged image with the
highest image quality is generated
( 0 30).

[Chromatic aberration correction] [On]
Perform accurate lateral color
aberration corrections suitable for
pixel shift shooting.

“Noise Reduction“ ( 0 36)
Option Settings Description

[Noise Reduction]
[Resolution-
priority pixel
shift merge]

Emphasize fine colors and details. Recommended when
shooting at low sensitivities from ISO 64 to ISO 500.

The same effect can be achieved with third-party
software by disabling the noise reduction function.
Noise may remain in the image, but fine colors and
details can be emphasized. It is recommended to select
this option when shooting 32 or 8 pictures because, in
these cases, noise is less noticeable than in normal RAW
(NEF/NRW) images.

Other
The longer the shooting time, the more susceptible the camera is to external factors, and it may not
be able to produce the desired result. Better results can be achieved by raising the ISO sensitivity and
shortening the shooting time ( 0 19).
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Example of uneven colors
(When the subject moved)

Example of mosaic patterns
(When the camera moved)

Example of bandings
(When the brightness changed)

Troubleshooting
Solutions to common issues are listed below.

Merged Images Show Disruption Such as Banding,
Uneven Colors, Mosaic Patterns, or Other
Distortions

Change the number of images to be generated in pixel shift merge and re-examine the combination
of pictures to be merged (0 31).
The pictures may not have been taken properly. Check the subject and shooting environment and
try again (0 20).

Bright Spots Appear on the Merged Image
Perform pixel mapping before shooting (0 21).
The image can be retouched with NX Studio. For more information, see NX Studio online help.
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Banding Shows in Depth-Composed Focus Shift
Images

How banding appears

The depth of field or focus position step width for focus shift shooting may not be optimal. Using a
smaller aperture (higher f-number) than f/5.6 and setting the [Focus step width] to [1] for focus shift
shooting may improve this issue. We recommend using software that suits your workflow and desired
quality, as results may vary by image editing software used for focus stacking.
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Not All Pictures Taken in Tethered Photography
Are Downloaded
When using NX Tether for tethered photography, the camera's internal memory may become full if
image transfer speed from the camera to the computer drops. Pixel shift shooting will be interrupted
when the internal memory becomes full. In these cases, a pixel shift merge cannot be performed
due to insufficient number of images for composition. This issue can be resolved by reconfiguring
the camera-computer connection, such as by using cables or interfaces that allow faster transfer, or
by changing the storage destination to an SSD with faster write speeds. You can also select [On]
for [Camera sounds] > [Beep] in the setup menu to easily determine when pixel shift shooting is
complete. See "Recommended Settings" > "Camera" > "'Camera Sounds' in the Setup Menu" for
details ( 0 49).
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